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DISCLAIMER 

Copyright © 2020 by DELMIAworks a Dassault Systèmes Company 

All rights reserved. No part of this publication may be reproduced, distributed, or transmitted in 
any form or by any means, including photocopying, recording, or other electronic or mechanical 
methods, without the prior written permission of DELMIAworks.  For permission requests, send 
an email to DELMIAworks.training@3ds.com “Subject: Permission to Reproduce Materials”.

mailto:DELMIAworks.training@3ds.com


DELMIAworks  TABLE OF CONTENTS 

2 | P a g e  
Copyright 2020, DELMIAworks, Inc., a Dassault Systèmes Company 

TABLE OF CONTENTS 

COMMUNICATING WITH DELMIAworks ...................................................................................................... 3 

COURSE INTRODUCTION .............................................................................................................................. 5 

BASIC NAVIGATION ...................................................................................................................................... 6 

SYSTEM PARAMETERS SETUP ...................................................................................................................... 9 

WORK CENTER ............................................................................................................................................ 11 

SHOP CALENDAR ........................................................................................................................................ 14 

INVENTORY ................................................................................................................................................. 16 

UOM CONVERSION FACTOR ...................................................................................................................... 19 

MASTER LOCATIONS .................................................................................................................................. 21 

INVENTORY TRANSACTIONS AND LOCATIONS.......................................................................................... 22 

BILL OF MATERIAL ...................................................................................................................................... 24 

SALES ORDER ENTRY .................................................................................................................................. 28 

WORK ORDERS ........................................................................................................................................... 31 

FINITE SCHEDULING AND PLANNING......................................................................................................... 34 

MATERIAL REQUIREMENTS PLANNING ..................................................................................................... 37 

RealTime™ PRODUCTION MONITORING ................................................................................................... 40 

PRODUCTION REPORTING BY SHIFT .......................................................................................................... 43 

SHIPPING..................................................................................................................................................... 45 

PURCHASING .............................................................................................................................................. 47 

PO RECEIPTS ............................................................................................................................................... 49 

GENERAL LEDGER ACCOUNT MAINTENANCE ............................................................................................ 51 

BANK MANAGER ........................................................................................................................................ 56 

GENERAL JOURNAL ENTRIES ...................................................................................................................... 59 

GENERAL LEDGER ACCOUNT ACTIVITY ...................................................................................................... 61 

FINANCIAL REPORTS ................................................................................................................................... 63 

TRIAL BALANCE ........................................................................................................................................... 64 

CUSTOMER MAINTENANCE ....................................................................................................................... 65 

ACCOUNTS RECEIVABLE PRIORS ................................................................................................................ 67 

VENDOR MAINTENANCE ............................................................................................................................ 68 

ACCOUNTS PAYABLE PRIORS ..................................................................................................................... 70 

APPENDIX: ACRONYMS .............................................................................................................................. 71 

APPENDIX:REPORTS AND GO LIVE ............................................................................................................. 73 



DELMIAworks   COMMUNICATING WITH DELMIAworks 

 

3 | P a g e  
Copyright 2020, DELMIAworks, Inc., a Dassault Systèmes Company 

COMMUNICATING WITH DELMIAworks  

Phone 
Corporate Office:   (805) 227-1122  5:00am – 5:00pm   PST   M-F 

Midwest Regional Office:  (805) 227-1122 Ext. 4  8:00am – 5:00pm   CST   M-F 

Email 
DELMIAworks.Info@3ds.com - General email address to inquire about the company or products 

DELMIAworks.Training@3ds.com – Send requests for training information 

DELMIAworks.Support@3ds.com – Post your questions for an email reply 

DELMIAworks.Sales@3ds.com – Send requests for sales information 

Web 
https://www.3ds.com/ 

The Dassault Systèmes website provides great information about the 3DEXPERIENCE Platform 

and the various products that Dassault Systèmes has in its portfolio to offer businesses across all 

industries and geographic regions.  

http://www.iqms.com 

The DELMIAworks website is an important tool used to promote the company as well as provide 

information on products, training options, contacts for key departments, upcoming events such 

as tradeshows or User Group conferences and more. 

MyIQMS 
http://myiqms.com 

A complete customer experience designed to offer increased access to information and support 

assistance, the MyIQMS online portal features many useful tools including a customer discussion 

board, free module-specific training library, and the “Ideas” form to submit software 

enhancement requests.  

In the Support section of MyIQMS, initiate a Chat conversation with a Support Tech, track all your 

pending and closed support activities, and access all document TechNotes, Manuals and 

Troubleshooting tools from anywhere, 24/7.  

To register as a user on MyIQMS, from the home screen select ‘Sign In’ on the top right corner, 

then select ‘Not a Member Yet? Click Here to Join’ in the lower left corner. The following screen 

will prompt you to create log-in information. Please be sure to check the ‘I am a current customer’ 

check box. An email will be sent once the user is approved.  Please note that confirmation could 

take up to one business day. 

mailto:DELMIAworks.Info@3ds.com
mailto:DELMIAworks.Training@3ds.com
mailto:DELMIAworks.Support@3ds.com
mailto:DELMIAworks.Sales@3ds.com
https://www.3ds.com/
http://www.iqms.com/
http://myiqms.com/
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FTP 
sftp://ftp.iqms.com 

DELMIAworks provides a folder on our servers for each client. This is commonly used to exchange 

or download files, documents and other information. If you’re unsure of your company’s user ID 

and password information to access the files available here, please contact our Technical Support 

department. 

IQReport 
The IQReport email newsletter keeps customers informed about important support, training and 

software news, as well as update information on the DELMIAworks system. To receive the 

IQReport, send an email to DELMIAworks.IQReport@3ds.com and include the names and email 

addresses of those to be added to the recipient list. 

USER CONFERENCE 
Hosted by Dassault Systèmes, the 3DEXPERIENCE World user conference is your best opportunity 

to meet not only DELMIAworks staff but also collaborate and network with other DELMIAworks 

users in a business casual environment.  Learn about future development, participate in best 

practice forums, attend targeted topic sessions and meet various industry experts brought in to 

enhance the seminar. For more information about the User Group event, visit the event website 

https://3dexperienceworld.com/.  Prior attendees’ rate this as both a great networking 

experience and highly educational!

ftp://ftp.iqms.com/
mailto:DELMIAworks.IQReport@3ds.com
https://3dexperienceworld.com/
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COURSE INTRODUCTION 

This introductory course explores the basic concepts and functionality of the DELMIAworks 

system. The goal is to provide a detailed overview of the system, while examining various 

concepts that require immediate user input. Such topics as part numbering, BOM building and 

usage, inventory, work order management, scheduling and RealTime™ monitoring are covered. 

In addition, the core data required to begin the implementation process is introduced. This would 

include accounting functions, basics lists, key data input, and more. Information covered in this 

course provides the groundwork for early and accurate input of data.  

Who should attend?   

This course is intended for the DELMIAworks implementation project team - those that will be 

responsible for bringing the system on-line at your site. The project leader and key managers 

from the accounting and manufacturing side of your company are highly encouraged to 

participate in this course. 

Prerequisites 

DELMIAworks software purchased and installed at your facility. Participants should have prior 

knowledge of manufacturing and/or accounting basics. 

Learning Objectives 

 Be proficient in basic navigation techniques in the core modules. 

 Understand the process flow of data from start to end in the system. 

 Learn key aspects of how core modules interact with each other. 

 Help participants understand and communicate system fundamentals to other users. 

Licensing 

The functionality covered in this class is focused on the core software package with the 

addition of the RealTime™ Production Monitoring functionality.  

These core modules include… 

 Work Centers, Shop Calendar, BOM’s, Inventory 

 Sales Orders, Purchase Orders, Work Orders, Finite Scheduling, Shipping 

 General Ledger, Journal Entries, Account Activity, Financial Reporting
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BASIC NAVIGATION 

DELMIAworks uses common features to navigate between data fields, screens and modules. 

These features assist the user in finding, entering, filtering and using system information for quick 

and easy communication of information.  These features include: picklists, the navigation bar, 

right click and “jump to”; speed buttons, report menus and Help documentation. 

 

Picklists – Initial List of Data for the Module 

 Search capabilities using the top search box 

 Wild card search using the ‘%’ sign in Search box 

 Sort by clicking on the column title or right click to change column sort 

 Multi-column sort using speed button  

 Click on column title once for ascending or twice for descending sort 

 Column moving and sizing 

 Show “inactive” information toggle button  

 Advanced filter function to add multiple sort attributes  
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Navigator Bar 

This feature is in the upper right of the screen for an individual record. 

 

 “Running Man” Bookmark – drag and drop to desktop for quick access to module record 

 Blue Arrows – move to different records 

 Green Plus – insert a new record 

 Red Minus – delete the record 

 Black Check mark – post edit/save  

 Red X – cancel from last save 

 Blue Half circle arrow – refresh screen 

Form/Table View 

 This speed button changes how you see individual records in a module.  

 Form View shows only details about the record in question 

 Table view brings up a screen of multiple records divided in sections 

Registered Reports Menu 

 A listing of all available reports for that module 

 Use scroll bar or enter text field at top of form to hyper-browse to the desired report.  

 Report Catalog – explanation of report (via right click) 

 Enter or Delete Selection Criteria – Filter by specific parameters  

 Change Report Print Destinations 

 Screen – Prints report to screen for viewing 

 Printer – Prints report to default printer 

 File – Compile report information into a saved file (Formats are RTF, Comma 

Delimited, ASCII, Adobe PDF, or Excel) 

 Email – Using stored email addresses 

 Ability to export reports (from Screen Print option) 

 



DELMIAworks  BASIC NAVIGATION 

8 | P a g e  
Copyright 2020, DELMIAworks, Inc., a Dassault Systèmes Company 

 

Help Menu  

 Contents tab lists the topics within that specific help file.  Expand the list by clicking on the 

plus (+) next to the topic. 

 Index tab lists all words that are part of the index. Type the word you are looking for in the 

white space at the top and the system will browse to the indexes that match. Once an index 

is found, double click on it to bring up the corresponding section in the help file. 
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SYSTEM PARAMETERS SETUP 

The System Parameters module is used to maintain your corporate information and 

system-wide defaults. This module contains the master drop down lists, such as Terms 

and Inventory Locations. The information and lists found in this module may be 

updated or changed at any time though it is recommended that you enter initial setup here. 

Launcher Bar > System Setup > System Parameters 

 

 Company File Information Tabs - Contains primary phone, fax, and address. 

 Application Tab 

 Options dialog boxes for Pick lists 

 Divisions and Launcher colors 

 Shipping Hours 

 Email Tab –Email settings for DELMIAworks 

 Web Tab –URL setup for workflows and Business Information dashboard 

functions 

 Credit Card Tab – Setup payment by credit cards 

 User Fields Tab– User Defined fields for additional data (In most every module) 

 Documents Tab – 3 features in most modules 

 Internal – Free form messages can be created and saved on that record 

 External – Documents stored outside of the DELMIAworks system 

 Email Correspondence – Outlook messages “dragged and dropped” here 
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 Sequential Numbering Tab 

 Reset document number sequences for go-live for seamless number transition 

 Regional Tab – Set default currency, UOM and Time Zone 

 Purchase Order & Sales Order Setup Tab  

 Set Purchase Order, Sales Order, Requisitions and Outsource defaults 

 AR Setup Tab – Setup finance charges and accounts receivable settings 

 GL Setup Tab – Default GL account settings including GL year and periods 

 Inventory Setup Tab - Settings that affect cost and variance postings 

 Label Setup Tab – Set default directories and other settings for labels 

 Reports/Forms Tab - Default reports linked to modules via the printer icon  

 Ship To/Remit To Tab - These are the addresses used to populate Vendor PO’s 

 Enterprise Tab – provides EPlant functionality  

 Supports different business entities, locations and/or financial reports 

 Payroll Setup Tab (Licensed module)- Setup account and tax ID data 

 Time and Attendance Tab (Licensed module) 

 Time Clock and Task Clock settings 

 Lists Menu – Sixty (60) data entry points to support various modules. A partial list 

includes: 

 Buyer Codes 

 Cost Elements 

 Downtime Codes 

 Employee Level 

 Inventory Classes 

 Inventory Locations 

 Inventory UOMs 

 Manufacturing Cells 

 Manufacturing Types 

 PO Types 

 Reject Codes 

 RMA Return Codes 

 Ship Via 

 Tax Codes 

 Terms 

 Etc… 

 Options Menu– System features to support select functions including: 

 Performance Analysis Setup - Analyze vendor performance against four criteria  

 IQTrace Tables  - allows tracking of modifications to selected tables and fields 

 BOL Parameters - Option to calculate BOL based on individual inventory items. 

 Packaging and Component Maintenance - Attached BOM operations 

 Boiler Plates Maintenance -Templates for Sales, PO and Pack Slip messages 

 IQMS Oracle ODBC DSN -Connections for ShipperLink and UPS WorldShip.
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WORK CENTER  

The work center module is where all machines or work areas/stations are created. 

Work centers must be setup before you can create quotes, BOMs, or scheduling work 

orders. Examples of work centers may include injection or blow-molding machines, 

extrusion machines, die casting machines, pad printers, heat stamping centers, and assembly 

areas. In addition to scheduling, work centers are key to calculating overhead costs and using 

RealTime™ functionality. 

Launcher Bar > Manufacturing > Work Center 

 

Create a New Work Center 

1. Select NEW from the picklist. 

a. User can also click the Green + Sign (Upper Right Navigation Bar) 

2. Select either a Manufacturing Type or a MFG Cell based on the new Work Center  

3. On the Work Center tab (top section) enter data in mandatory fields: 

a. Work Center # (up to 25 Alpha/Numeric characters) 

b. Description of work center (Alpha/Numeric Characters) 

c. Center Type – Groups similar work centers for costing and scheduling purposes 

d. Manufacturing Cell – Allows a logical grouping of work centers 

4. Configure work center to RealTime (If Required) 

a. General Tab (Lower Left Section) – Select “Connected to RT Server” box 

b. On the menu bar go to Options > Assign RealTime Information  



DELMIAworks  WORK CENTER 
 

12 | P a g e  
Copyright 2020, DELMIAworks, Inc., a Dassault Systèmes Company 

i. Highlight the work center to be assigned (left panel) 

ii. Highlight an Available Address (“white” lines in the upper right section) 

iii. Click the Green Left Arrow to attach the address and work center 

5. Set Overhead rates by Work Center (Lower right section) 

a. Click “Use Master Center Type Cost Settings”  

i. Pulls rate from the Center Type attached to work center 

b. Alternatively, can manually set an overhead rate: 

i. Unclick “Use Master Center Type Cost Settings” dialog box 

ii. Click Post Edit then enter the desired rate in lower, right section  

6. Assign Default Inventory Locations to Work Centers (Optional) 

a. On the menu bar go to Options > Shop Floor Disposition Parameters 

b. Set the default “IN Transaction” location (Finished parts going IN this location) 

c. Set the default “OUT Transaction” location (Raw materials going OUT) 

 
7. Assign Reject Codes by Work Center(Optional) 

a. Highlight the Work Center tab in the top section 

b. Click the Reject Code tab in the lower section 

c. Click the 3 dot ellipsis in the Reject Code field and choose from the list 

d. Click the Green + Sign to choose additional reject codes 

8. Assign Downtime Codes by Work Center(Optional) 

a. Highlight the Work Center tab in the top section 

b. Click the Downtime Code tab in the lower section 

c. Click the 3 dot ellipsis in the Downtime Code field and choose from the list 

d. Click the Green + Sign to choose additional Downtime codes  
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LAB EXERCISE: Creating a New Work Center 

1. Create a new work center with a Manufacturing Type of “Injection” 

a. What is your work center #? _____________ 

2. Attach this work center with an available RealTime address  

a. What is your RealTime address #? ___________ 

3. Insure the new work center uses Master Center Type Cost Settings 

a. What is your Center Type name? ____________ 

b.  What is your overhead $ rate? ____________ 

4. Set Shop Floor Disposition locations for IN and OUT transaction 

a. What is your IN location? _______________ 

b. What is your OUT location? _____________
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SHOP CALENDAR 

The Shop Calendar is where the number of shifts, days and hours are set. This 

information determines work center capacity, scheduling work orders, material 

planning, and production shift reports. In addition, the values entered here are used 

to tell RealTime™ when to stop counting production against one shift, and begin counting against 

the next shift, then auto-generate a production shift report.  

Launcher Bar > Manufacturing > Shop Calendar 

 

Set the Default Calendar (Default Tab) 

1. Click System > Default line (In the Origin and Source columns) 

2. On the right Calendar section of the screen 

a. Enter the # of Shifts the company works 

b. Enter the total Hours/Day worked 

c. Enter the # Days worked each week 

i. Click the Calendar icon to set the days of week worked  

3. In the lower, right Shift section of the screen 

a. Enter the Start time, based on a 24-hour clock, for each shift 

b. Hours per shift populate automatically 
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4. Top menu: Calendar > Set Default Calendar(see below)  

 

Manufacturing Cell Tab 

 Optionally set calendar based on Manufacturing Cell 

Work Center Tab 

 Optionally set calendar based on an individual Work Center schedule 

Add Holidays to the Shop Calendar 

1. Top menu: Calendar > Add Holidays 

2. Enter the time off start date/time in the From field 

3. Enter the time off end date/time in the To field 

4. Choose to Apply to Default Calendar and All Work Centers 

5. Click OK, then confirm holiday is set 

a. Go to Calendar > Schedule Days Off (Holiday time will be shown in green)  

 
 

LAB EXERCISE:  Set a Default Calendar 

1. Create the Default Calendar for your system  

a. Set # of shifts; Hours/Day and Days/Week 

b. Enter the Start times for each shift 

2. Create weekend time off (Calendar > Set Default Calendar) 

3. Create Holiday time off for the next 3-day weekend
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INVENTORY 

Inventory is the heart of the DELMIAworks system and affects all other modules.  

There are 11 different tabs and hundreds of possible fields to enter data.  It is critical 

to enter accurate data in the chosen fields for your company. 

Launcher Bar > Manufacturing > Inventory 

 

Create a New Inventory Item 

1. Open the picklist > Click New button 

a. Select an Inventory Class 

b. Enter a Revision if required 

c. Enter a unique Item # 

d. Enter a Description 

e. Enter an Ext. Description (Optional) 

f. Choose a UOM 

g. Enter an EPlant if required 

2. General Tab (Purchased Items) 

a. Enter Lead Days 

b. Enter Buying Multiples(Optional) 

c. Enter Min/Max Order/Reorder Pts (Optional) 
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3. General Tab (FG Items) 

a. Enter Selling Multiples (Optional) 

b. Enter Minimum Sell QTY (Optional) 

Associate AKA Buying Record 

 

1. Click on the AKA Buying tab 

2. Click the Green + sign in that tab 

3. Select a vendor from the picklist 

a. Enter AKA Item and Description 

b. Enter other optional vendor data 

4. Enter Pricing for selected vendor (Bottom Section) 

a. Enter Quantity and associated Price 

b. Enter additional QTY price breaks by clicking the Green + sign 

Additional Tab 

 Maintains information about the item based on Class and other characteristics 

Standard Costing Tab 

 Holds costing information for purchased and manufactured items 

Buy/Sell Pricing Tab 

 Contains Purchasing or Selling price breaks by quantity levels 

Manufacturing Tab 

 Links between an inventory item # and a BOM for a manufactured part 
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LAB EXERCISE #1: Create FG Item for a Wagon 

1. Create the Item # with a class of FG:  ___________________ 

2. Enter the Item Description:    ___________________ 

3. Enter Selling Multiples of 50 and Minimum Sell QTY of 100 

4. Enter SO Item Information note: Restocking Fee of $100 After 30 Days 

5. On the ADDITIONAL Tab enter an NMFC code of 11565 

6. Enter an AKA Selling record for Customer of ‘AUT00’ 

7. Enter an AKA Item # and Description for AUT00  

8. In the AKA Price Breaks enter 3 different price breaks for the Wagon 

a. Quantity of 100 ________ 

b. Quantity of 250 ________ 

c. Quantity of 500 ________ 

 

LAB EXERCISE #2: Create WP Item for a Wagon Cover 

1. Create the Item # with a class of WP:  ___________________ 

2. Enter the Item Description:    __________________
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UOM CONVERSION FACTOR 

DELMIAworks provides a utility that allows the system to automatically convert one UOM to 

another UOM. This feature can be used when a raw material item is ordered from the Vendor in 

one unit of measure, but then inventoried and consumed in a different unit of measure. This 

feature can also be used for manufactured items where the item is manufactured and inventoried 

in one unit of measure, but then sold in another unit of measure.  

 

Create a UOM Conversion Using a Multiplication Factor 
1. In the Main Inventory tab click the icon to the right of the UOM field 

2. Enter the new UOM by choosing from the drop down list  

3. Choose Multiply in the Divide/Multiply column 

4. Enter the numeric conversion value in the Factor field 

5. Check the OE Default box or PO Default box (Optional) 

6. Click Post Edit check mark to calculate the converted On Hand QTY 

7. Compare the converted On Hand QTY to the native On Hand QTY 

Create a UOM Conversion Using a Division Factor 
1. In the Main Inventory tab click the icon to the right of the UOM field 

2. Enter the new UOM by choosing from the drop down list  

3. Choose Divide in the Divide/Multiply column 

4. Enter the numeric conversion value in the Factor field 

5. Check the OE Default box or PO Default box (Optional) 

6. Click Post Edit check mark to calculate the converted On Hand QTY 

7. Compare the converted On Hand QTY to the native On Hand QTY 
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LAB EXERCISE: Create a UOM Conversion for Purchasing 

1. Search for P/N CC-C1-59.070 (Steel Coil), note the native UOM 

2. Click the UOM conversion icon. Is the current conversion quantity correct? _______ 

3. Correct the current UOM conversion (lbs. to tons) 

a. Choose the Multiply function 

b. Enter the correct numeric Factor and click the PO Default box 

c. Click Post Edit.  How many tons of Steel Coil are On Hand? ______ 

4. Do the same exercise but use the Division function and change the Factor 

5. Do you get the same quantity of Tons as when Multiplication was used? _____
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MASTER LOCATIONS 

Locations are where material, parts or tools reside and are required before quantities can be 

assigned to or relieved from inventory.  Locations maybe very specific such as “Row1- Shelf A- 

Bin 1” or very general such as “Receiving Warehouse”.  Used in Inventory, Production reporting 

or Work Centers as Disposition Designators.   

Manufacturing Tab>Inventory>Miscellaneous>Inventory Location Info > Locations 

 

Create New Location 
1. Manufacturing Tab>Inventory>Miscellaneous>Inventory Location Info > Locations 

2. Click the Green + sign 

3. Enter the Location code (Alpha/Numeric mixed permitted) 

4. Enter a Description 

5. Confirm Correct EPlant is selected. 

LAB EXERCISE: Create a New Master Location 

1. Add a new Location for raw material receiving.  

a. What is Location code?   _________ 

b. What is the Description?  __________ 

2. Flag this location as “Non Allocatable” 

3. Mark this location as a “Receive Designator”
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INVENTORY TRANSACTIONS AND LOCATIONS 

Inventory transactions are at the root of inventory control in DELMIAworks.  All 

inventory items exist in locations and any change to an inventory quantity or a 

change in location is accomplished by completing a transaction.  Transactions are 

used to add, subtract and move inventory.  All inventory includes a location and 

an optional lot number. 

Launcher Bar > Manufacturing > Inventory Transaction and Locations 

 

Move Inventory to a Location 

1. Search for P/N AD-1600-CS-ASSY 

a. Right click and view possible options in the lower left section 

2. Click on the quantity then “drag and drop” into the open space below 

3. Search for location NC-1 then enter a Quantity of 100 and click OK 

4. Enter Non-Conform Reason 

5. Click NO to “create an MRB?” 

6. Notice the color of the NC-1 location 

7. Notice the On Hand quantity change in the upper right of the screen 

8. Click on the Trans Log speed button on the tool bar  
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LAB EXERCISE: Add Inventory to a New Different Location 

1. In the Transaction screen find an item with a description of “RACK”. 

a. What part number is it? ____________ 

2. Right Click and add a new location for this part.  

a. What’s the location?  ______________ 

3. Right Click and Add to Location.  Add 100 parts. 

4. Choose the Tran Code of MANUAL CORRECTION 

5. Enter a Reason of “Found in Engineering” and click OK 

6. Confirm the transaction details via the Trans Log.



DELMIAworks  BILL OF MATERIAL 

24 | P a g e  
Copyright 2020, DELMIAworks, Inc., a Dassault Systèmes Company 

BILL OF MATERIAL  

DELMIAworks uses the Bill of Material (BOM) module to define how items are 
manufactured in your environment. This information includes a tooling description, 
part numbers, material designation and usage, rate of production, packaging and 
process notes. The system supports multiple manufacturing types, such as 
Assembly, Generic, Injection, Outsource, Stamping, etc. Each type of manufacturing 
contains unique elements that complement the manufacturing method. 

Launcher Bar>Manufacturing >BOM 

 

Create a New BOM (Primary Material) 

1. Select New from the picklist dialogue box. 

2. Choose the BOM Manufacturing Type of Injection 

3. Enter key data on the General BOM Info Tab 

a. Enter the MFG # (Alpha/Numeric) 

b. Description and Customer Fields are Optional 

c. Choose a primary material (Class PL) in the center section 
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d. Enter a Tool # in the bottom section 

e. BOM Manufacturing Details section 

i. Enter MFG Cell (required if using RealTime™) 

ii. Enter the Center Type 

iii. Enter Cycle Time in seconds 

iv. Optionally enter Setup Hours, Eff. Factor, Scrap and Labor 

f. Production Summary – Key metrics based on cycle time, Efficiency and Scrap % 

4. Item Details Tab 

a. Attach the Inventory item to the BOM 

 
i. Click the Green + in the Item Information section (Top, right) 

ii. Click the Pick Item button and search for the correct P/N to attach to the 

BOM 

iii. Enter Weight of the primary material and cavitation.  Click OK 

iv. On the next Confirmation screen click Yes to continue 

b. Add Components, Packaging, and Routing/Operation (Left Section of Screen) 

i. Use speed buttons below or Right Click to add 

 
ii. BOL information for first Packaging item (Lower, right section) 

1. Add QTY of finished item to be contained in the carton 

2. On the Details tab add Gross and Tare weights for the package 

5. Other Key BOM features 

 Certified Employees Tab - Employees that are certified to run this specific BOM 

 Auxiliary Equipment Tab –Auxiliary equipment that can be associated to a BOM  

 Runs Best (Options) – Work centers that show efficiency data to run that BOM 

 Reject/Downtime Codes (Options) – BOM specific inventory or machine codes 
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Create a New BOM (Outsource) 

 

1. Select New from picklist dialogue box 

2. Choose the BOM Manufacturing Type of OUTSOURCE 

3. Enter key for data on the General BOM Info Tab 

a. Enter the MFG # (Alpha/Numeric) 

b. Description and Customer Fields are Optional 

c. Choose an Outsource MFG Cell 

d. Choose the Outsource Vendor  

i. Note an Outsource Work Center is created with this vendor attached 

e. Enter the number of days it will take the vendor to complete the work 

f. Enter Scrap % for the parts if needed 

4. Item Details Tab 

a. Add the Inventory item to the BOM (Item received back from the vendor) 

1. Click the Green + in the Item Information section (Top, right) 

2. Click the Pick Item button and search for the correct P/N to attach  

3. On next Confirmation screen click Yes to continue 

b. Add the Components/Packaging sent to the Vendor  
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LAB EXERCISE #1: Create an Injection WIP BOM  

1. Create an Injection BOM for the Wagon Cover created in the Inventory Lab 

a. What is your BOM #?   _________________ 

2. Enter your Primary material and Runner/Sprue weight 

a. What is item # of your primary (resin) material?   ___________ 

3. Enter the data in the BOM Details section, including Labor 

a. What is your Center Type? ____________ 

b. What is your Cycle Time and Scrap %?  ____________  ___________  

4. Add a Tool.  What is your Tool #?  _____________ 

5. On the Item Details Tab attach the WP Inventory # to your BOM 

6. Add the Weight in Grams of your cover.  How many grams is your wagon cover?  _____  

7. Add a piece of Auxiliary Equipment to your BOM.  ______________ 

LAB EXERCISE #2: Create a Generic Finished Good BOM  

1. Create a Generic BOM type for the FG Wagon P/N created in the Inventory Lab 

a. What is your BOM #?   _________________ 

2. Enter the data in the BOM Details section, including Labor 

3. On the Item Details Tab attach the FG Inventory # to your BOM 

a.  Attach all the components for your wagon 

i. Hint – there should 6 items to attach (not including the FG #) 

b. For packaging add a Gaylord and Gaylord Dividers 

i. On the Gaylord box add the Gross and Tare weights. 
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SALES ORDER ENTRY 

DELMIAworks Sales Order functionality is broken down into three sections. The 

Header information includes customer bill to, ship to and contact information. The 

Line Item section highlights items ordered and pricing data.  Lastly, the Releases 

section outlines when items must ship and drives work order creation for the shop. 

Launcher Bar > Sales/Distribution > Sales Orders 

 

Creating a New Sales Order 

9. Select NEW from picklist. 

10. Header Section > Select a Customer 

a. Verify or Change Bill To, Ship To and Contact information 

b. Verify or Change FOB, Terms, and Ship Via 

c. Add PO# for customer (Optional but recommended) 

d. Notes: 

i. Add an SO Note if desired 

ii. Customer Note will default from Sold To Customer # 

iii. Ship To Note default from Ship To Customer #  
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11. Line Item Section > Add unlimited line items in 3 ways: 

a. Sales Items added from Inventory  

b. Miscellaneous (non-inventory) Items  

c. Sales Items added from AKA Selling Items  

d. Choose the P/N and enter the blanket quantity of items sold 

i. The sales price will default after clicking Post Edit 

 

12. Release Section - is used for entering the total number of deliveries for each line item 

a. Includes these quantities: Release, Shipped, Left to Ship and Cumulative shipped 

b. Includes these dates: Requested, Promised, Must Ship and Shipped Date 

c. There are 3 ways to populate the release section: 

i. Manually enter the quantity and date for each release 

ii. Drag and Drop from the Line Item section 

iii. Right Click and Generate Releases (Preferred for multiple releases) 

1. Enter number of releases 

2. Enter QTY per Release or Use Blanket Quantity 

3. Enter Start Date (First Delivery Date) 

4. Enter Interval (Days between Shipment) 

5. Click Apply to all Items if desired 

6. Click Append (Or “Overwrite” if changing current releases) 
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LAB EXERCISE: Creating a Sales Order 

1. Create a new sales order for customer AUT00 (AUTORAMA) 

a. Add a PO #.  ___________ 

b. Change the Terms to Net 30 

c. What is the Ship Via?   ____________ 

2. In the Line Item section: 

a. Click the Add from AKA Items icon 

b. Click the Multi-select Inventory icon 

c. Choose your wagon then enter a Blanket QTY of 500 

d. Click Post Edit.  What is the sales price of your Wagon?  ___________ 

3. Create the releases to deliver the Wagons 

a. Drag and Drop the Blanket QTY in the Items section down to the Release QTY 

i. What date defaults into the Promise Date?   ___________ 

ii. What date defaults into the Must Ship Date? ___________ 

iii. Delete that release line. (Not the Item Detail line!) 

b. Recreate the Releases by Right Clicking > Generate Releases 

i. Enter 10 for Number of Releases 

ii. Choose Use Blanket Quantity 

iii. Enter Start Date 2 weeks from today 

iv. Enter 14 days in the Interval field 

v. Click Append.  What is the Must Ship Date of the last release?  ________ 

4. On the Header Speed bar find the Printer icon 

a. Choose Print Order Acknowledgement Report 

b. On the Destination tab choose Screen 

c. Verify all data is correct.
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WORK ORDERS 

Work Orders communicate production to the shop floor to build specific items based 

on the attached BOM.  Work orders are generated manually, by the system (using 

Update Schedule) to fulfill demand, keep stocking levels, or handle other work 

needed. 

Launcher Bar > Manufacturing > Work Orders 

 

View the Work Order Picklist 
 Origin: 

 Planned WO’s are generated from system demand – SO’s, Forecast, Auto MRP 

 Manual WO’s can be created for samples, R&D projects, engineering tests, etc. 

 Can also be generated from the Forecast module and Auto-MRP 

 Work Order # -System generated numeric identifier 

 New #’s are created for Unscheduled and Unfirmed WO’s via Update Schedule 

 Manufacturing Type – Defines the BOM format, work order form and reports 

 Item # - Inventory part to be made.  Answers, “What am I building?” 

 Manufacturing # - BOM attached to Item.  Answers, “How am I building the item?” 

 Planned Production – QTY to build. Answers “How many do I need to satisfy demand?” 

 Must Start Date – Answers: “When do I need to start work to meet customer due date?” 



DELMIAworks  WORK ORDERS 
 

32 | P a g e  
Copyright 2020, DELMIAworks, Inc., a Dassault Systèmes Company 

 

View the Work Order Screen 
 Top Section 

 Work Order # - System generated 

 Firm dialog box – “Locks” quantities and delivery dates for this work order 

 Fields populated from the BOM: 

 MFG #, Labor, Customer, Material (primary), Center Type, Setup and Cycle(Sec) 

 Cycles Planned/Required – Calculated from Delivery QTY and Cavitation 

 Production Hours – Calculated from Cycles Required, Cycle Time and Setup Hrs 

 Must Start Date – Calculated backwards from customer promise date less Prod 

Hrs 

 Configuration Details Section(Lower left) – Shows Item #, Description and tool cavitation 

 Also includes speed buttons for Routing Diagram and Printing Labels 

 Delivery Quantities Section: 

 System Generated WO’s - Usually populates from SO release section 

 Manual WO’s – User entered fields (only quantity and Delivery date required) 
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LAB EXERCISE: Creating a Manual Work Order 

1. Search for and create work order for P/N H-15-RED.  

a. Say yes to add customer Sandy, Inc. 

b. What is the BOM # on the work order? ___________ 

c. What are the setup hours? _____ 

d. What is the cycle time? ________ 

e. How many cavities does the tool have?  ____________ 

2. Enter a Delivery Quantity of 5,000 and delivery date 1 week from today. 

a. In the Order field enter “Mrktg Samples”.  Post Edit. 

b. What are the Production Hours? _________  

c. What is the Must Start Date? _______ 

3. Click on the Routing Diagram in the Configuration Details section. 

4. Click the Print speed button in the Header and print to Screen.
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FINITE SCHEDULING AND PLANNING 

Finite Scheduling is used to load work orders onto work centers where manufacturing 
will occur and prioritize the order to run. The loading of your schedule drives material 
planning, parts projection, labor and machine capacity planning.  

Launcher Bar>Manufacturing Tab>Finite Manufacturing Scheduling 

 

Working with the Finite Schedule 

1. Choose a Manufacturing Type or specific MFG Cell  

2. Use the Blue Navigation arrows to find a work center with work orders scheduled 

a. Work center # and description appears on the title bar 

3. Top, Left Section of Scheduling Screen 

a. Lists work orders in the sequence they are to run 

b. Key info includes: WO#, MFG #, Start/End dates, Tool #, Lot #, and Hrs to Go 

c. Right Click to see the available options and “jump to’s” 

4. Top, Right section –Key data about the highlighted work order 

a. Data Includes: Must start date, Scope, Run size, Primary Material and QTY 

required 

5. Bottom Section shows the demand that created the work order – Usually a sales order 

a. Right Click to see the available options and “jump to’s” 

6. Scheduling functions can be managed via: Schedule menu, Speed icons or Right Click 

a. Add jobs, Move Jobs, or Delete jobs from the schedule 

b. Add Downtime, Edit a Job and Setting up the next Job 
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Running Update Schedule 

Finite Scheduling > File > Update Schedule > Regenerate Schedule 

1. Click the Recalculate button; Click Yes to run Update Schedule.  This process: 

a. Deletes unscheduled work orders 

b. Determines new requirements and creates new work orders 

c. Calculates new material requirements, work center and labor capacity 

Scheduling Parameters 

Finite Scheduling > Options > Scheduling Parameters 

 

 Sets Scheduling Scope and MFG Run Size in Days 
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LAB EXERCISE: Add/Move a Job to the Work Center Schedule 

1. Go to an Injection work center in Finite Scheduling 

a. Insure it is a work center with same center type as your Wagon Cover BOM 

2. Click on the Green + or right click and Insert Work Order to see the unscheduled WO’s 

a. If you don’t see a WO for your covers click on the Override Center Type icon 

b. How many cover work orders do you see?  ___________ 

c. Why are there multiple lines with same work order #?  ________ 

3. Multi-select 2 WO’s to schedule then click Apply and exit the unscheduled WO pool 

4. Drag and drop one of those WO’s to position #1. 

a. What is the Must Start Date and End Date for the 2nd WO? ______________ 

5. Click on the work order NOT in position #1 

a. Use the Speed icon to Move that work order to another work center 

b. Try to choose a work center with the same center type (tonnage) 

6. Is your cover WO on the Material Exceptions list? (Hint – use your color chips)



DELMIAworks  MATERIAL REQUIREMENTS PLANNING 

37 | P a g e  
Copyright 2020, DELMIAworks, Inc., a Dassault Systèmes Company 

MATERIAL REQUIREMENTS PLANNING 

The material exception list displays all raw materials that are required to meet your 

schedule, but are not available, or on order. It is the single most important material-

planning screen because it contains not only what items are needed, but also when 

they are needed and in what quantity. 

Launcher Bar > PO/Receiving > Material Requirements 

 

Material Exception List 

 

Projected Exception Tab 
 Top Section – Key Columns include: 

 On Hand QTY 

 Total Exception - Total demand from the work orders less any on hand inventory 

 Left to Order - Total Exception less amounts not received on purchase orders 
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 Middle Section: 

 Click on the Blue Checkmark speed icon- Displays Exception details 

 The Must Order by is calculated by taking the Should Arrive By less the Lead Days 

 Must Arrive By is the day prior to the first Work Order less any Inspection Lead 

Days 

 Should Arrive By is the Must Arrive By date less the PO Safety days -counting all 

days 

 Bottom Section – Links demand from WO’s and sales orders to the item being evaluated 

 Right Click Options 

 Top:  Jump to Inventory, MPS, PO History, Vendor RFQ and Add to PO 

 Middle:  Add to PO for Item, Add to PO for Vendor, DRP Demand and Jump to PO 

 Bottom:  Jump to Work Order or Jump to Sales Order or Inventory  

Daily Material Staging 

 

 By Material tab – Materials required within the scope are shown by work center below 

 By Work Center tab – Shows all work centers with the materials needed at each 

 Lower section shows WO# and date required 
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LAB EXERCISE: Create a PO via the Projected Exception Screen 

1. On the Projected Exception screen choose and click Evaluate Item # BX-GAYLORD 

a. Note the dates for Must Order by ______  

b. Must Arrive _____  

c. Should Arrive _____ 

d. Jump to Inventory and add 5 Lead Days and 1 Inspection Lead Days – Post Edit 

e. Back on the Projected Exceptions click the Calculate speed icon 

i. Did the dates above change?   ___________ 

2. In the Middle section, multi-select the first 3 line item requirements 

a. What are the “Should Arrive Dates” for those line items? 

b. ____________  _____________ ____________ 

3. Right click and choose Add to PO-Vendor; Create a NEW purchase order 

a. What is your new PO #?  ____________ 

b. What are the promise dates on each PO release line?  

c. Do they match Must Arrives? 

4. Recalculate and click the Evaluate the BX-Gaylord again. 

a. What color did those line items turn?  What does this mean?
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RealTime™ PRODUCTION MONITORING 

RealTime™ provides the core tools for the acquisition and disbursement of production 

data. Actual production data is available to anyone on the network - in RealTime™. This 

allows user input of rejects and downtime reasons when they occur.  RT reduces 

Production Reporting tasks by automatically generating Production Reports. 

Launcher Bar > RT Machine Monitoring>RealTime™ Production Monitor 

 

1) Choose MFG Type or a MFG Cell 

2) Review the color chips on the jobs that are running. 

3) Change the view on the speed button bar from Part Numbers to Work Orders to Quality 

4) Click the speed buttons for Executive, then the Plant View. 

5) Right click to see a multitude of options and “Jump To” availability. 

  



DELMIAworks  RealTime™ PRODUCTION MONITORING 

41 | P a g e  
Copyright 2020, DELMIAworks, Inc., a Dassault Systèmes Company 

Individual Machine Monitoring 

This function provides the user with general job information along with a Production 

Summary on the work center. From this single screen, you can view everything about 

an individual job. 

 

 General Job Information Section 

 WO #, Sales Order # , Customer, BOM and Work Center data 

 Color Coded for cycle time with in or out of range tolerance 

 Production Summary Section 

 Cycle time data; Hours data 

 OEE Tracking (Overall Equipment Effectiveness) 

 Items Section – Tracks data by P/N in real time. Includes: 

 Total parts, Shift parts run, Parts to Go, Bad Parts (rejects) 

 Cavitation, Hours to Go and Performance factors 

 Cycles Graph Section includes bar chart presentation of last 50 cycles 

 Summary tab presents the same data in tabular form 
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LAB EXERCISE: Working with a RealTime™ Work Center 

1. In the RealTime Production Monitoring choose Injection MFG Type 

2. Find a work center that is running your Wagon Cover if possible 

a. Alternatively find any work center that is running 

b. Choose the Individual Center Info speed button 

3. What is the Last Cycle time ______ and AVG Cycle time______? 

4. How many “Hours To Go” are there? ______ 

5. In the Items Section Right click and Reject 10 parts 

a. What did the Scrap % go to?  ________ 

6. How did that affect the Quality Factor above (OEE)? _____ 

7. Right Click and Floor Dispo 50 parts. 

a. Right click, Jump to Inventory 

b. Review the Transaction Log for the item reported.
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PRODUCTION REPORTING BY SHIFT 

DELMIAworks uses its RealTime™ functionality to provide automatic production 
reports after each shift. This feature can also report non-RealTime™ work orders.  
The module helps verify floor dispositioned material, backflushed items, rejects 
items, machine hours, downtime and labor hours. 
 

Launcher Bar > Manufacturing Tab > Production Reporting by Shift 

 

Working with Shifts 

 Select a Shift Report – Dialog box with 3 tabs opens 

 New Tab – Unprocessed Shift Reports by Date, Shift and MFG Cell 

 Opened Tab – Unarchived Shifts that may, or may not be Dispositioned 

 Archived Tab – Archived shifts to facilitate Runs Best and other calculations 
 Buttons/Action on right side of dialog box 

 OK – Opens the selected shift report 

 Non-RT – Opens a form to report work orders from non RT work centers 

 Discard – deletes the selected shift 

 Archive – Moves the selected shift(s) to an archived status 

 Labor Alloc -Enter employees’ labor hours and associated inventory items  

 Discard Empty - Delete shift reports where there are no cycles or transactions 

 Un-Archive – Reactivate archived shifts to make corrections 
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Processing a Shift Report 

 

1) Work Center/Work Order Section (Top, Left) 

a) Verify/Edit Cycles, Prod Hrs, SU Hrs and Total Down time 

b) Right click for “Jump to’s”, Downtime, Labor Hrs or Work Center log 

2) Work Order Detail section (Top Right) - Various data about the highlighted work order 

a) Verify/Edit Regrind, Foreman, Operators and Employee Hrs 

3) Item Detail Section (Bottom)  

a) Verify/Edit – Good Parts and Rejects quantities 

b) Right click for Reject, Jump to Inventory, Disposition, BOM functions 

4) Menu > Disposition > Auto Disposition 

a) Disposition all work orders in the shift 

LAB EXERCISE: Disposition a Shift 

1. Select a shift on the NEW tab for Cell ‘PASO INJ’ 

2. Find a work order with cycles populated and edit the Prod Hrs and SU Hrs 

3. In the Item Section below report 100 Rejects for Burns (right click) 

4. Adjust the Good Parts so there are no UnRpt Rejects 

5. Auto Disposition the report – what color did the Item section turn? ________ 

6. Right click and Jump to Inventory.  Then view the Trans Log for these transactions.
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SHIPPING 

DELMIAworks offers two types of packing slips to assist in documenting parts leaving 

your facility. Manual packing slips are used for non-sales order shipments. System 

Generated packing slips are created from sales orders, relieving inventory, initiate 

invoicing, and accounts receivable functions. 

Launcher Bar > Sales/Distribution > Shipping and Packing Slips 

 

Sales Order Packing Slips 

 Header section  

 Fields defaulting from SO: Customer, Ship Via, Ship Days, FOB,  

 PS info fields :Pallet, Freight Charge, Tracking #, BOL Note and Pool Bill# 

 Middle section 

 Item information pulled from the sales order release line. 

 Invoice and RMA status color chips 

 Bottom Section 

 Line Location/Lot# tab 

 Comments tab 

 Packing slip - Free form entry or Boiler Plate via right click. Prints on packing slip 

 Sales Order – Flows from the SO item note. Information only, does not print. 

 BOL tab: calculate and display weight, volume box data and class information 
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Creating Sales Order Packing Slips (Not Using Pick Tickets) 

1. Create a report of possible shipments 

a. Open a Packing List record > Reports > Print > Ship Picklist – Available for 

Shipment 

2. Click ‘New’ from pick list or the ‘+’ on the top right of the module 

3. Assign items to the packing slip based on Item # and/or Sales Order# 

a. Highlight line items on the left and click Green Arrow to move the right section  

4. Enter the Pick QTY from the correct Location and Lot# line  

5. Click OK and a new Packing Slip will be created(posted) 

Creating Packing Slips (Using Pick Tickets)  

1. Non Sales Order mode- choose shipments from 2 tabs: 

a. Ready for Shipping – inventory is on hand by the Must Ship Date 

b. Possibly Available – on hand and work orders in process by Must Ship Date 

2. Sales Order mode – Options > Parameter (Based on Must Ship Date only) 

a. Ignores on hand and possibly available quantities 

3. Choose a Customer line order to “Pick” and click OK 

a. Middle Section - Enter a Ship Quantity 

b. Bottom Section (Relieve Location) – double click line item to choose 

Location/Lot# 

c. Enter picked quantity and Post Edit 

4. On the Speed button bar click Convert to Pack Slip 

LAB EXERCISE: Create a Packing Slip (No Pick Ticket) 
1. From the Launcher bar create a new packing slip for your Wagon sales order 

a. If you don’t see any in stock, choose a New Location of FG-1  

b. Enter 50 in the quantity field 

2. What is your Packing List #? ______________ 

3. What is the Ship Via and Ship Days for your Packing Slip?   __________ ____ 

4. Add a Freight Charge of $150.
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PURCHASING 

Purchase Orders (POs) are entered through the PO module or Material Exception List 

in Scheduling. They are used to track vendor order status, buy inventory and expense 

items, show pricing and schedule arrival dates to meet production requirements. 

Launcher Bar > PO/Receiving > Purchase Orders 

 

Purchase Order Screen 

 Header section – key vendor data including Contact, FOB, Ship Via and Terms 

 Also includes Buyer, Approved, Confirm To and workflow options 

 Middle Section - Item on Order data including Item# and Description 

  QTY on Order, Price/each, Total Price 

 Can order items by Inventory #, AKA Buying # or Miscellaneous # (Non Inventory) 

 Release Section – Outlines when the items above are to be delivered 

 Includes color chips for complete, partial and non-received shipments 

 Includes Acknowledged dialog box to confirm vendor approval 

 There are 3 ways to populate the release section: 

 Manually enter the quantity and date for each release 
 Drag and Drop from the Line Item section 
 Right Click and Generate Releases (Preferred for multiple releases) 
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LAB EXERCISE: Create a Purchase Order 

1. Create a PO for P/N 000050 from vendor Francis Plastics for 30,000 lbs. 

a. What is the price per pound of this material?  ___________ 

b. Add a contact in the header section. (Hint - Drop down arrow) 

2. Create 10 releases for 3,000 lbs. each starting 1 week from today. 

a. Each release should be 14 days a part.   

b. What is the date of the last delivery? ______________ 

3. Create, then Add a Miscellaneous Item to the PO for a Blending Fee of $125 

a. Drop and drag the release date to be 3 days from today. 

4. Use the Blue Check mark on the speed button bar to acknowledge all releases.
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PO RECEIPTS 

The Receiving module will track receipt of goods on a Purchase Order into a location and 

pulls actual cost from PO price and plus allocated freight.  It also can record Rejects for 

inventory and purchasing purposes. 

Launcher Bar > PO/Receiving > Receiving by PO 

 

General Header Section 
 Contains Vendor, PO, Freight and Requested by Data 

 Tool bar Speed Icons 

 Form/Table Toggles by Vendor and PO number 

 Toggle to Show/Hide Closed PO’s 

 Freight Allocation  

 Diskette – Post ALL receipts for this PO 

Line Item Middle Section 
 Items on that Vendor’s PO that can be received 

 Tool bar Speed Icons 

 Binoculars – search for a line item on this PO 

 Reset Inspection Due Alert – reset next incoming inspection Line Item fields 

 Line Item Fields 

 Item # and Description 

 Include Order QTY, QTY Received, Left to Receive 

 AKA Buying data – vendor # and descriptions 
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Received/Rejected Section 
 Individual receipt and reject information per line item 

 Tool Bar Speed Icons  

 Single Diskette - Post Receipt 

 Multiple Diskettes – Post Rejects 

 Trash Can - Void Receipt/Rejects 

 Printer – print receiving ticket or labels 

 Line Item fields:  

 Received/Rejected QTY:  manually entered or filled via the “drag and drop” 

 Receipt and Date fields automatically fill in when posted. 

LAB EXERCISE: Receive a PO  

1. Search for the PO # created in the Purchasing Lab 

2. Receive 3,000 lbs., click Post Edit.   

a. What color does the line turn?  _______ 

3. In the Rejected section enter 100 lbs.  

a. Enter Contaminated for the Reason. Post Edit. 

4. Post the received amount of 3,000.  

a. Enter a Tran Code of PO-RECV on the next screen. 

5. Post the 100 lbs. of rejects.  Append the amount back to the PO. 

a. Enter Tran Code of P-SCR-REJ 

b. Click the Scrap dialog box and choose scrap reason P-CON 

6. Jump to Inventory > Trans Log and review the PO Receipt and Reject transactions. 

7. Jump to the PO.  Was the PO ‘appended’ for the rejected amount? 
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GENERAL LEDGER ACCOUNT MAINTENANCE 

This section will review setting up and maintaining the General Ledger including; the following 

section will review assigning default GL accounts in System Parameters. 

 Account Types 

 Creating Accounts 

 Defining GL Year and Periods 

 Reference Codes 

Account Number Structure 

The first step that must be completed when setting up the GL is to define the account structure. 

One segment is established as the Natural Account. Other segments can be added which the 

system will use for GL Plugging. The account structure determines definition and appearance of 

GL account number. Careful planning is important to minimize the need to make modifications 

to the account structure once it is established. The account structure can be up to 50 digits in 

length. 

Launcher Bar: GL Tab>Chart of Accounts>File>Account Structure 

 

The account structure tool can be used to create additional codes, modify field lengths, or 

remove the separators. Experimenting with the Start and Length fields will create different 

account formats. DELMIAworks will not change the account structure until the user completes 

the process. Again, the account structure should not be changed once it is established. Careful 

planning is important to minimize the need to make a change to the structure. 
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Account Types 

DELMIAworks supports unlimited account types and sub-types. Each account type must be 
assigned to one of six major account types. These six major types are integral parts of the 
accounting system and cannot be edited, deleted or added to. They are used by DELMIAworks 
to assign the account to a financial report.  

The six major types are: 
 Assets - Current Assets, Fixed Assets and Others 
 Liabilities - Current Liabilities, Long-Term Liabilities and Others 
 Revenue - Revenue, and Other Income. 
 Expense - Cost of Goods Sold accounts and Other Expenses. 
 Owner’s Equity - Owner’s Equity, and Retained Earnings. 
 Statistical - Statistical accounts can be used to track non-financial information such as 

number of employees, square feet, production quantities, etc. 

Once the account types are created, they will be available to be attached to a posting account 

within the chart. Performing this function is discussed in the next section, Building Your Chart of 

Accounts. A grouping mechanism designed to assist in combining “like” accounts for financial 

reporting purposes. Once the account types are created, they will be available to be attached to 

a posting account within the chart.  

Launcher Bar> GL>Chart of Accounts>Options>Account Type Maintenance 
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Create or Maintaining Accounts 

1. Create user defined sub-account types under one of the Major types, right click to 

create new account type 

a. Retained Earnings -:  In order for current earnings (net income) from Income 

Statement to roll into retained earnings, your retained earnings account must 

have the Retained Earnings type. Also, there can only be one Retained Earnings 

account (or only one per EPlant) 

b. Cost of Goods Sold - Must read as such, not COGS. Enables Gross Profit 

calculation on Income Statement 

2. Maintain based on account number structure - Separators will automatically populate, 

just enter digits.  

3. Check Boxes 

a. Hide from Options - Hides obsolete or special accounts from drop down views in 

various posting areas of the software, eliminating postings to these accounts by 

department. 

b. Hide from All Picklists – account number will be inactive going forward.  

c. Cost Source Required - Ensures the account number can only be used if a cost 

source is attached. Used with MRO, Project Manager and Fixed Asset modules. 

Changing or Deleting an Account 

 You can change the account number once it has been created. All history from the 

previous account will follow the new account.  

 If no posted general ledger transactions exist for an account, the account can be 

deleted. 

View Account Numbers Via: 

 Form View - View one account in the screen. Accounts may be created in this view 

 Tabular View - View multiple accounts on one screen. Accounts may be created in this 

view. 

 Tree View - View Multiple Accounts by Account Type (with YTD total). Accounts cannot 

be created here 
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Creating Reference Codes 

Create optional reference categories and codes that allow for tracking of additional information 

of account activity. Reference codes can be assigned to postings within the General Journal, AR 

and AP invoicing, PO, SO and cash receipts modules. Reference codes can also be inactivated. 

 

Defining GL Year / Periods 

DELMIAworks supports unlimited GL years and each year can be broken into a maximum of 13 

periods. Financial years can begin and end on any selected date. 

 Use the Create Periods button to create multiple periods at once. If entering 12 periods 

the period start and end date will coincide with the month start and end date. 

System Parameters > GL Setup tab or Chart of Accounts > Options > Define Periods. 
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Change Period Status 

 GL Status will always be the first opened and last closed with the exception of INV 

Status. 

 INV status may be closed and cleared at any time. It is not dependent on the other 

period statuses INV Status prevents inventory postings to a specific period by selecting 

close. If it is necessary to revert back to open, clear the Closed value from the field.  

 Use Grid view dropdown or Form view checkboxes 

 Never Opened (N/O) - This option appears when a period is first created or if a 

period was never opened. 

 Open - Periods cannot be posted to until they are opened. The GL must be 

opened first before AP and AR journal can be opened. 

 Closed - The AP and AR journal must be closed first before the GL can be closed. 

Closed periods may be re-opened if necessary.
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BANK MANAGER 

The Bank Manager module is used to record all banking information, reconcile bank accounts, 

browse GL Batches for deposits and payments as well as review the check register. It is located 

on the  

Launcher Bar> GL>Chart of Accounts>Options>Bank Manager 

 

Bank Account Information 

Enter General Banking information for all Bank accounts related to General Ledger such as 
Account#, Description, Last check# issued, and select the Cash GL account. 

 Assign a Suspense GL account – Optional and  

 Exclude from Cash Analysis – will not be included in the Cash Analysis module 

EC (Electronic Commerce) Information 

ABA Transit Routing #, Immediate Destination, and Immediate Origin – this information is 

supplied by the bank and is used for identification purposes, direct deposits, etc. Company 

Identification – this is your company ID used by the bank and is typically the company’s EIN 

(Employer Identification Number) 
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Bank Account Reconciliation  

Can be accessed from the GL tab > Bank Reconciliation icon or from the Bank Account 

Using the Bank Information Pick List , select bank account to reconcile 

Launcher Bar> GL>Bank Reconciliation 

 

 Reconcile as of: Enter ending date from bank statement 

 Filtering is done by Batch date not Period end date to calculate the Book 

balance. 

Bank Balances & Calculations 

 Bank Balance: Enter ending bank balance as noted on bank statement 

 Deposits in Transit - calculation of un-cleared deposits (can be manually overridden) 

 If checks marked reconciled are unchecked, the deposit amount will be added to 

‘Deposit in Transit’, for accurate reconciliation  

 Total - The system calculates the bank’s ending balance plus any deposits in transit less 

any outstanding checks plus GJ entries for the total. This total must match the book 

balance on the right side of the screen to post reconciliation. 
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Tab Options for Reconciliation 

1. Selecting Clear Checks Options on the CLEAR CHECKS TAB. 

a. Displays all cleared and non-cleared or only non-cleared checks  

b. Display AP only, Payroll only, or both AP and Payroll 

c. Clear multiple checks – allows you to clear all selected records at once rather 

than clearing one by one using the checkbox 

i. Right click to View Posted Checks 

ii. Date Cleared field – defaults to reconcile date but can be manually 

adjusted 

2. Selecting Clear Deposits Options on the CLEAR DEPOSITS TAB. 

a. Display all deposits or only outstanding deposits 

b. Clear multiple deposits – allows you to clear all selected records at once rather 

than clearing one by one using the checkbox 

i. Right click to browse cash receipts batch 

3. Creating Adjusting Entries from the ADJUSTING ENTRIES TAB. 

a. Select period 

b. Enter amount and description 

c. Select offsetting GL account 

4. GL Batch Activity on GL ACTIVITY TAB 

a. View bank GL Batch Activity – CR, CD, GJ, and PR 

b. Clear GJ Entries - 'clear' per batch  

5. Completing Reconciliation 

a. File > Post Reconciliation; Select Post Reconciliation option when complete. 

File Menu > Non-GL Checks 

For ‘first time’ use to reconcile bank account, when coming from a legacy system; enter as a 

prior check; allow for accurate tracking of prior checks against Bank balance; Non-GL checks 

do not affect general ledger 

Options Menu > Display Entries Cleared During Reconcile 

When it is checked the system will write a row to the Bank_Reconcile_tmp table as an entry is 

cleared, and the entry in the temp table will continue to display even when you have the filter 

set to “Show non-cleared checks/deposits/GJ entries.”  

 The purpose is to be able to view only the records that you are currently working with (if 

you change the filter to 'Show all cleared and non-cleared checks/deposits/GJ entries', 

then the system just provides a list of everything that has ever been posted).  

 If it is not checked, cleared entries will not display when the filter set to 'Show non-

cleared checks/deposits/GJ entries'. When the Bank Reconciliation is posted, the tmp 

table will be cleared.
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GENERAL JOURNAL ENTRIES 

Most journal entries are completed during the common posting routines found throughout 
DELMIAworks. However, when the occasions arise that need direct input, use the General 
Journal Entry functions. General Journal entries can be used to post manual, recurring or 
reversing entries to any open periods. Beginning balances are also created using the General 
Journal module (Free Form Group type). 

Launcher Bar > GL > General Journal 

 

Groups VS Batches 

Entries are stored as Groups, posted as Batches. Groups are temporary files or unposted GL 

transactions. There are no requirements to post a Group before beginning another Group. Once 

the user posts a Group, only then will the system assign a Batch number. 

 Groups and Batches are used in GJ, Cash Disbursements, Cash Receipts, and optionally 

in AP Invoices. Each module maintains a separate group/batch numbering system. 

Creating Free Form Entries  

1. Select Group Type, Year and Period 

2. Enter GL account(s) using the ‘+’ in the middle section of the screen and amount 

3. Ability to have the system repeat description, date and reference code (right click or 

speed button) 

4. Balance to Distribute (at bottom of screen) must be zero to post group 

Creating Recurring Entries 

1. Select group type and recurring time frame 

2. Period, Monthly, Quarterly, Bi-weekly or Every nth day 

3. General Journal displays total cycles and total processed thus far 

4. Enter general journal detail information as usual 

5. When setting up recurring entries, the accounts and detail will not populate on the next 

cycle until the previous cycle is posted. 
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Creating Reversing Entries 

1. Select Group Type, Year and Period 

2. Display reversing cycles 

a. System will create an unposted entry for the reversing portion; users will be 

allowed to choose the final period of a year as the first posting month, but a 

warning will appear. 

Creating Statistical Entries 

1. Select Group Type, Year and Period 

2. Select Statistical GL Account 

3. Enter a Value, debits and credits do not apply 

4. Statistical accounts are used to track non-financial information. This will be a single 

value journal entry (not a balanced Debits/Credits entry). 

Creating Templates 

1. Use templates for commonly reoccurring adjusting entries to save time and minimize 

opportunity for error. Templates are setup and applied from the File menu.  

2. Sequence numbers – maintain accounts in the same order as entered so once a 

template has been applied to a new group, the sequence is the same 

3. Leave the Debit and Credit fields empty if the quantities will vary 

4. Enter a percentage amount to enable split across accounts; optional 

5. Insert from template onto an opened journal entry by choosing the Templates icon 

6. Optionally, add as template; this enables you to create a journal entry and still save it as 

a template for later use. 

File Menu 

 Import General Journal>Follow Wizard; Tool used to import a PREPOST GJ entry 

 Import External File 

 Tool used to import data into the database 

 Requires an import schema 

Options Menu 

 Ask for Period/Year before posting – double check you are posting to the correct period 

 Show TRANSLOG records associated with this group – available for entries created in PIT 

 Post all for all users, or post all for individual user. 
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GENERAL LEDGER ACCOUNT ACTIVITY 

The General Ledger Account Activity module is used to view Batch summary and detail 

information. In addition, drill down tools allows the user to research account and transaction 

history down to the original source document. Account activity can be viewed by GL year, period 

or date range. It is located on the GL tab of the main Launcher Bar. 

Launcher Bar > GL > Account Activity 

 

Review by Period or Date Range 
1. Select Fiscal Year to View Activity 

a. Select to view information by Period or a specified date range only 
2. Select a GL account to view 
3. Selecting Apply Selection (or double clicking on account) will display detail information 
4. Review balance and activity totals 

a. Stat. Value/YTD Stat Value – balance for Statistical Type accounts. No Debit or 
Credit balance, since it does not apply 

5. Double click on detail to receive drill down information  
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Drill Down to Batches 
1. Review batch detail: 

a. Batch number, Date, User ID, Amount, Total Balance, Running Balance 

b. Source – GJ (general journal), AR (accounts receivable), CR (cash receipts), AP 

(accounts payable), CD (cash disbursements), BM (bank manager), PR (payroll), IJ 

(IACJ) 

2. Right-click or double click for Batch Access to view General Journal entry for entire batch  

a. Batch Date – update Batch date or view batch date history 

 

Drill Down to Document 
1. Right-click or double-click for Document Access to review specific document. 

a. AR Invoice, AP Invoice, Cash Receipts, Cash Disbursements, General Journal, 

Payroll Checks or TRANSLOG Records
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FINANCIAL REPORTS 

The Financial Reports module supports the basic financial reports – Balance Sheet and Income 

Statement. The Financial Report tool can be used to build a table of records that meet reporting 

requirements. Then, using Crystal Report Writer, create a report to reflect those requirements. 

An unlimited number of templates can be created. Each can contain as few or as many accounts, 

in any order desired. 

Launcher Bar > GL > Financial Reports 

Creating Financial Reports 
1. Create user-defined report templates 

a. Balance Sheet 

b. Income Statement 

c. Budget Comparison 

2. Drag and drop 

a. Easy report creation and editing 

b. Change order of accounts;  

c. Keep within same account type  

3. Create and edit Header/Footer 

a. SUM option – enter SUM in Header to summarize account information 
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TRIAL BALANCE 

The Trial Balance module displays the current GL year, by period, with year to date debits, credits 

and balances. The lower portion of the form displays the GL account numbers, description, 

starting balance at the beginning of the period, the total debits and credits during that period, 

the period balance, and year to date balance. Double-click on GL account line to view all batches 

posted to the selected GL Account for the selected GL Period. It is located on the GL tab of the 

main Launcher Bar. 

Launcher Bar > GL > Trial Balance 

 

Trial Balance 

1. Choose the period of interest and double-click, or use Apply Selection button 

2. Double-click on GL account to view Account Activity 

Trial Balance Reports 

 Trial Balance 

 Trial Balance - Summary YTD 

 Trial Balance As of 

 Trial Balance Detail



DELMIAworks  CUSTOMER MAINTENANCE 

65 | P a g e  
Copyright 2020, DELMIAworks, Inc., a Dassault Systèmes Company 

CUSTOMER MAINTENANCE 

The Customer Maintenance module in DELMIAworks allows for multiple contacts, 

multiple shipping and billing addresses, credit status limit, customer status types, as 

well as tracking notes and documentation about the customer.  

Launcher Bar>AR >Customer Maintenance 

 

Customer/Credit Data Tab  

 Header Section 

 Customer #, Customer address, Main Contact, Phone, URL 

 Lower Section 

 Credit Status Tab:  

 Status Dates, Terms, Statement Date 

 Sales data: Sales Person, Territory, CSR and AR reps 

 Credit Limit, CRM fields 

 Auto Invoice Tab – 1 Invoice per Packing Slip or Unique PO/PS 

 Miscellaneous Tab: 

 Various A/R, Credit Card, Tax and Ship Via fields 

 Packing Slip Settings 

 Note Fields for Sales Order, Cash Receipts and AR Invoices 

 Forms/Reports Tab – set customer specific reports for various forms 
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Contacts Tab 

 Set unlimited contacts for this customer 

 Add title, Phone/Fax numbers 

 Add email (required for Auto-EForm) 

 Dialog Boxes for Auto-EForm communication 

Ship To Tab 

 Header Section 

 Ship To Address and Contact (Unlimited Ship To’s per Customer #) 

 Associate Ship To addresses with Bill To addresses 

 Details Tab 

 Setup Ship Via, Carrier Account # and Ship Days. 

 Various other settings specific to that Ship To ID 

 Forms Tab – Shipping reports and form specific to that Ship To ID 

Bill To Tab 

 Header Section 

 Bill To Address and Contact  

 Forms /Report Tab 

 Setup custom documents for Invoices 

LAB EXERCISE: Create a New Customer Record 

1. Find a customer record from your current system 

2. Recreate this customer in DELMIAworks.   

a. What is your customer #? _________ 

3. Set Auto Invoicing for “One Invoice per Unique PO/PS” 

4. On the Miscellaneous Tab: 

a.  Set Packing Slip Creations to “One PO# per Packing Slip” 

b. Enter a Packing Slip Note 

5. Create “Ship To” entity for this customer other than the address on the main customer. 

a. On the Details tab Create a Ship Via and enter Ship Days
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ACCOUNTS RECEIVABLE PRIORS  

The Accounts Receivable Invoice module is used to track receivables still due from customers in 

your prior system. While the screen looks like the regular AR Invoice screen, the main difference 

is the notation of “Prior Entries” at the top and that the invoice will not post to the GL. 

Launcher Bar > File > Accounting >Accounts Receivable > Prior 

 

Enter Prior System Invoices  
1. Enter Invoice # 

2. Enter Invoice Date 

3. Due date will calculate if terms are filled in 

4. Change GL period (optional) 

5. Enter Quantity of 1 

6. Enter total amount due in Unit Price field 

7. Post (Print the pre-posting batch review to check totals, prior to posting).
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VENDOR MAINTENANCE 

The Vendor Maintenance module allows for setup of multiple contacts; remittance 

addresses as well as tracking notes and documents about the vendor. It is located 

on the AP or System Setup tab of the main Launcher Bar. 

Launcher Bar > AP > Vendor Maintenance 

 

Vendor Information Tab 
 Vendor # - required field, up to 10 characters either user-defined field or system 

generated  

 Maintain primary information – address, contact, phone, fax, etc. 

 Accounting Tab 

 Credit Limit  

 GL Account - default GL account for vendor payables (debit account) 

 1099 Setup 

 Terms - Default terms the vendor issues that carry over to the PO module 
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 Rating Tab - QA Assurance Rating & Vendor Rating 

 Status Levels set per Vendor 

 Approved, Not Approved, Payment Hold, Receive Hold, Inactive 

 Subject to Rating – Vendor will be included on the Vendor Performance 

Analysis Reports 

 Miscellaneous Tab 

 Customer – Vendor attachment 

 PO Type maintenance 

 PO and AP Notes 

 Form/Reports – can attach custom forms for PO and AP documents 

Remittance Tab  
 Entities to send or remit payments 

 Can attach information for Bank and EFT processing 

Contact Tab  
 Setup unlimited contact for each vendor 

 Name, Title, Phone and Email 

 Can flag if the Default contact 

 Auto EForm PO box to have purchase orders sent electronically 

LAB EXERCISE: Create a New Vendor Record 

1. Create a new vendor in DELMIAworks from your old system 

2. Setup a credit limit and Terms 

3. Give them a status of Approved 

4. On the Miscellaneous tab add a PO Note for: “Confirm early deliveries” 

5. Add yourself a default Contact and insure you are get PO via Auto EForm.
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ACCOUNTS PAYABLE PRIORS  

The Accounts Payable Invoice Prior module is used to track payables due to vendors and other 

expenses that have not been paid from your old system. As with AR Priors these invoices are like 

their AP Invoice counterpart with the exception of the “Prior Entries” notation and the absence 

of affecting the general ledger. 

Launcher Bar > File > Accounting >Accounts Payable > Prior 

 

Enter Prior System Invoices  
1. Enter Invoice # 

2. Enter Invoice Date 

3. Due date will calculate if terms are attached 

4. Enter total amount due 

5. Option to change GL period  

6. Enter ‘QTY (Inv.)’ of 1 

7. Enter total amount 

8. Post (Print the pre-posting batch review to check totals, prior to posting.)
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APPENDIX: ACRONYMS 

Acronym Definition 
 

Acronym Definition 

AKA Also Known As  FIFO First In First Out 

AML Approved Manufacturer List 
 

FMEA Failure Mode Effect Analysis 

AP Accounts Payable 
 

I/O In and Out 

API Application Programming Interface 
 

IATA International Air Transport 

Association 

APQP Advanced Product Quality Planning 
 

IBAN International Banking Account 

Number 

AR Accounts Receivable 
 

IBT Internet Based Training 

ASN Advanced Shipping Notice 
 

ICT Intercompany Transaction 

ATP Available to Promise  IIS Internet Information Services 

BI Business Intelligence 
 

IQMS IQMS is not an acronym 

BOM Bill of Materials/ Bill of 

Manufacturing 

 
KPI Key Performance Indicator 

BOL Bill of Lading 
 

LD LetDown, Let Down Ratio 

BDE Borlen Database Engine 
 

LIFO Last In First Out 

CAPA Corrective Action Preventative 

Action 

 
MES Manufacturing Execution System 

CAR Corrective Action Report 
 

MEL Material Exception List 

CoA Certificate of Analysis 
 

MFG Manufacturing  

CoC Certificate of Conformance 
 

MIU Machine Interface Unit 

(RealTime™) 

COD Cash on Delivery 
 

MLA Mid-Level Operator 

COGS Cost of Goods Sold 
 

MMU Machine Monitoring Unit 

(RealTime™) 

CRM Customer Relationship 

Management 

 
MPS Master Production Schedule 

CSR Customer Service Representative 
 

MRB Material Review Board 

CTP Capable to Promise 
 

MRO Maintenance Repair Overhaul 

DBA Database Administrator 
 

MRP Manufacturing Resource Planning 

or Material Requirements Planning 

DHR Device History Record 
 

MSL Moisture Sensitivity Level 

DRP Distribution Resource Planning 
 

MT Main Tool or Maintenance 

ECN Engineering Change Notice or 

Number 

 
MTD Month to Date 

ECO Engineering Change Order 
 

MTO Make to Order 

EDI Electronic Data Interchange 
 

MUD Master Unit Die or Modular Unit Die 

EFT Electronic Funds Transfer 
 

NMFC National Motor Freight Classification 

EIN Employer Identification Number 
 

ODBC Oracle Database Control or            

Open Database Connectivity 
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EIQ EnterpriseIQ  ODG Oracle Data Group 

EPEI Every Part Every Interval  OE Order Entry/Sales Order 

ERP Enterprise Resource Planning  OEM Original Equipment Manufacturer 

ESG Educational Services 

Group/Training 

 PIT Post Inventory Transactions 

FG Finished Goods  PK or 

PKG 

Packaging 

PLC Programmable Logic Controller  SIC Serialized Inventory Control 

PLM Product Life Management  SID Shipment ID/System Identifying 

Database 

PQ Process Qualification  SO Sales Order 

PRA Production Reporting Assistant  SPC Statistical Process Control 

PRLS Production Report by Labor/Shift  SPG Specific Gravity 

PRS Production Reporting by Shift  SQL Structured Query Language 

PRW Production Reporting by Work 

Order 

 SRID Selected Release ID 

PSG Professional Services Group  SS or 

SSS 

Spreadsheet Server 

PSW Part Submission Warrant  STD Standard 

QA Quality Assurance  TL Tooling 

QC Quality Control  UD User Defined  

RAN Release Authorization Number  UDF User Defined Field/Form 

RCP Resource Capacity Planning  UNC Universal Naming Convention 

Rev Revision  UOM Unit of Measure 

RFQ Request for Quote  UPC Universal Production Code 

RG Regrind  VAT Value Added Tax 

RM Raw Material  VTC Virtual Training Class 

R&R Repeatability and Reproducibility  VMI Vendor Managed Inventory 

RMA Return Material Authorization  WC Work Center 

RT  RealTime™   WIP or 

WP 

Work in Progress/Process 

RT 

Server 

RealTime™ Server  WMS Warehouse Management System 

RWK Rework  WO Work Order 

SCAC Standard Carrier Alpha Code: 

unique 2-4 letter code used to 

identify transportation companies 

 YTD Year to Date 

SER Software Enhancement Request    
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APPENDIX:REPORTS AND GO LIVE  

Reports to Review Prior to Go Live 

The below list of reports is a standardized list of commonly used reports that will all need to be 

reviewed prior to going live on the DELMIAworks system. The common theme among these 

reports is that they are all used externally – meaning that people outside your company (such as 

customers, vendors, shipping companies, etc.) will see and review them. 

Core Reports: 

 Sales Order Acknowledgement 

 Return Material Authorization form 

 Packing Slip 

 Manual Packing Slip 

 AR Invoices (pre-post and posted) 

 Purchase Order 

 AP Check 

Additional Reports (based on module usage): 

 Bill of Lading 

 Packslip BOL report 

 BOL Header report (BOL module) 

 Commercial Invoice 

 CRM Quotes 

 Engineering Quotes 

 Payroll Check
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NOTES 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


